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Welcome

Welcome to the world of Xeltek SUPERPRO programmers. Xeltek has produced the

SUPERPRO line of IC programmers since 1985. Our motto is to provide high value

products at affordable prices. In the past 27 years, Xeltek has produced a string of

highly popular and successful programmers including SUPERPRO, SUPERPRO 11,

SUPERPRO III, SUPERPRO V, SUPERPRO 680, SUPERPRO 8000, SUPERPRO 3000U, and SUPERPRO
9000 models.

SUPERPRO 3000U is the first model to incorporate both PC connected and stand-

alone modes operations combined into one programmer. It is also the first programmer to break the
barrier of 40,000 devices supported in the industry. SUPERPRO 3000U is by far the most popular IC
programmer in the industry today.

Pushing the barrier further, Xeltek is proud to announce the family of SUPERPRO
7500 programmers. SUPERPRO 7500 retains all the good features of SUPERPRO
3000U, but, in addition, it is designed to program today's large size devices efficiently and effectively.

Feature Highlights

® The SUPERPRO includes ultra high speed programming via 32bit RISC MCU
device. This is especially suitable for programming high capacity NAND
Flash devices

® A 144 pin driver support is built-in to provide efficient programming of large
pin count devices, an additional pin expander module is not necessary to
program large pin-count devices.

® The SUPERPRO operates with a PC for engineering purpose or in stand-
alone mode, without a PC, for repeat production mode programming. This
provides seamless migration from engineering to production.

® The SUPERPRO communicates through a USB 2.0 port and operates on most
Pentium-based, IBM compatible desktop/notebook computers.

® The SUPERPRO comes with a standard 48-pin DIP ZIF socket and supports

optional socket adapters to accommodate PLCC, TSOP, SOIC, SOP, QFP,
TSSOP and BGA package types.

® The programmer and software supports Windows XP, Windows Vista,
Windows 7, Windows 8 , Windows 10, etc.

For authorized users, the SUPERPRO can provide for automatic generation of



electronic serial numbers.

User Manual Organization

This manual includes the following major chapters,
® An introduction to the SUPERPRO series, including the system requirements
and the software and hardware installation

® Detailed explanations on the commands and the programming procedures
® Information about error messages and common problems

® An Appendix that includes the customer support information

Note: The software prevails in any discrepancy between it and the user manual, due

to any upgrades of the software. The information in this document may be subject to
change without notice.



Chapter 1 Overview of SUPERPRO,, 7000 Series

This section provides a brief introduction of SUPERPRO (1.1), software features (1.2),
structure of the handbook (1.3), system requirement for the installation (1.4), and
package content (1.5).

1.1 Introduction to SUPERPRO

The SUPERPRO is a menu-driven software that operates a series of cost-effective,
reliable, and high-speed universal programmers. SUPERPRO communicates
through a USB 2.0 port and operates with most IBM-compatible desktop and
notebook computers that based on Pentium. Menu-driven software interface makes
all the operations quite user-friendly.

1.2 Software feature
The USB 2.0 Series supports:

®*  Windows XP, Windows Vista, Windows 7, Windows 8, Windows 10, etc.

® More than 43,000 types of devices, including E/EPROM, PLD, MCU, FLASH,
etc.

® Compatible with many types of file formats, such as Binary, Intel (linear &
segmented) Hex, Motorola S, Tektronix (linear & segmented), Jed, pof, etc.

® [t supports a plug-in test (48 pins or less) to detect defective chips, improper
insertion and pins that are poorly contacted.

® SUPERPRO has an integral full-screen buffer editorial environment with
commands such as fill, copy, move, swap, etc.

®  Electronic serial numbers are generated automatically.

1.3 Structure of this User's Guide
The content of this User's Guide is structured into three major sections,

Chapter 1 is an overview and introduction of the SUPERPRO, describing the
system requirement, installation of the hardware and software.



Chapter 2 - Chapter 5 are detailed specification and explanation of all the
features, commands, and function modules.

In Appendices, there are supportive information and guide for trouble-shooting

1.4 System requirements
The minimum system configuration requires:

® A desktop or laptop computer with Intel Pentium or an equivalent processor
® Windows XP, Windows Vista, and/or Windows 7 operating system

® 1 GB free space on the hard drive

¢ Standard (USB 2.0) compliant socket

® ACDdrive

1.5 Package content
A standard SUPERPRO programmer package includes:

e A Programming host module
e A Power supply unit

e A USB 2.0 connection cable

e A CD contains driver software
e A user's registration form



Chapter 2 System Installation

This chapter provides a brief guidance on how to install the SUPERPRO software
and connect the programmer hardware properly.

NOTE: To avoid complications during the installation process, you must setup the
software before connecting the programming hardware (the USB device) to your
computer. That is, installation through the "Add New Hardware Wizard" of
Windows system is NOT recommended (this might lead to wrong drivers with a
different compatible device ID).

2.1 Software Setup

Select the software to setup your SUPERPRO programmer either from the CD-
ROM or by downloading the program from the Xeltek website. Instructions for both
methods are described below.

2.1.1 Software setup from CD

1. Insert the CD into the CD-ROM drive.

2. If the setup program does not start automatically, run SETUP.EXE located in
the root directory.

3. Select the appropriate programmer model.

4. Click Setup.

NOTE: Each model has its own software and they are NOT compatible.

2.1.2 Download the software from website and setup (recommended)

You can also download the specific software for a certain model at Xeltek
website:_http://www.xeltek.com. Select the icon to download the appropriate file for
your programmer. Once you have saved the file to your computer, run it to setup
the software. The following procedure describes the setup process step by step.

1. Once the setup program is running, a dialog box displays to allow the user
choosing a preferred language. Select one from the drop down list and click
OK to continue
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2. An installation wizard will be displayed (as illustrated below). Click Next to
continue.

Welcome to The Installation Wizard

This Wizard will guid wou through the steps required
to install Programmer Control Software on your
computer .

It' = strongly recommended that wou exit all ather
windows programs before runming this setup program.

WARHIHG . Thi= program is protected by copyrigtht law
and international treaties.

Click FHext to continue, or Cancel to exit Installation.

Hext Cancal

3. A License Agreement will be displayed. Click I Agree to continue.
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License Agreement

Please review the following License terms carefully.
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If wou accept the license agreement, click I Agree to continue. You
must accept the agreement to install the Control Software.

| < Back | [ I Agrec l | Cancel |

4. Choose the Destination Location in which the driver software will be
installed. Once the destination file folder is selected, click Next to proceed.
 supeoo 750, Verin 10 S ==

Select Deztination Location

YWwhere should the zoftware be installed’?

To continme, click Hext. To install to a different folder, click
Browse and select another folder.

Destination Fold

C:hspTS00

Space required : Z202. 2 ME
< Back | [ I hgree l | Cancel

5. Another dialog box will be presented and allow the user to choose whether

creating a start menu icon and/or a desktop icon. Once correctly check the
tick box(es), click Next to continue.



SUPERPRO 7500, Version X

Select Additional tasks

Which additional tazks should b f d?
ich additional tasks should be performe =

Select the additional tasks wou would like Install Wizard to
perform while installing.

Create a start menu icon

Create a desktop icon

| < Back | | Hext > | | Cancel |

6. Check the previous selections and click Install to start the installation

ﬁSUPERPRO 7500, Versi S|

Ready to Inzstall the Program

the ‘Wizard is ready to begin installation.

T N

If wou want to rewiew or change any

of wour installation settings, click Back Click
Cancel to exit the Wizard

Current settings:

De=stination Folder:
C:h=pTs00

Start Menu Folder:
SUPERFRO 7500

Create a desktop:

SUFERFED 7500

¢ Back | | Inztall | | Cancel

NOTE: If you are using the Windows Vista system, the operation system may

display the following dialog box to ask you whether to install the software. Select



_ Install this driver software anyway. i
134 Windows Security .

@ Windows can’t verify the publisher of this driver software

# Don't install this driver software

You should check your manufacturer's website for updated driver software
for your device,

+ Install this driver software anyway
Only install driver software obtained from your manufacturer's website or
disc. Unsigned software from other sources may harm your computer or steal
information,

(v See details

7. Once the installation is completed, click Finish.

EE—

Install Wizard Completed

The Install Wizard has successfully installed the

software. Click Finish to exit the wizard.

Lau.m:h the program

2.2 Hardware and Driver Installation
After you set up the software, you can install the hardware and driver. The

following procedure explains the installation process.

NOTE: Do not follow these steps below if you have not yet setup the software (see

section 2.1).



1. Make sure all other programs are closed during the installation process.

2. Connect the programmer module to the computer through the USB port.

3. Turn on the power switch of the programmer module.
When you connect the new hardware, the system initiates the New Hardware
Wizard, which locates the driver from the software you have just installed.

The system displays alerts one at a time, illustrated below. The alerts on your

system may be slightly different.

i) Found New Hardware *
IJSE Device

i) Found New Hardware *

USEZ.0 programmer

F =
i) Found New Hardware ¥

Your new hardware is installed and ready ko use,

4. After you open the application software for the programmer, the system
automatically starts the initialization. If it does not, make sure the
programmer is securely connected to the computer and that the power switch

1S on.



Chapter 3 Quick Guidance of the Software Features

This chapter is a quick guidance of the SUPERPRO,, software. It describes the
functions and features of the programmer that are most frequently used. The
SUPERPRO 7500 provides two programmers in one, they are: PC mode for engineering

and Stand-alone mode for production.

® Under PC hosted mode, a PC controls the programmer via a high-speed USB
connection to program a chip.
® Under stand-alone mode, the user controls the programmer via 20-characters,
4-line LCD display with 6-KEY keypad.
In this chapter, all the features being described are in PC mode, while the stand-

alone mode is described elsewhere.

3.1 The User's Interface (main screen)
The main SUPERPRO screen is illustrated below. Each part of the user interface is

labeled with a number and described below.
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1. The Menu Bar provides access to the File, Buffer, Device, Option, Project,
and Help menus.

2. The Tool Bar offers quick access to many commonly used functions.

3. The Command Window enables shortcut to many commands and operations.

4. The Programmer Statue Panel shows the state of the current project and

programmer.

5. The Device Panel shows the connected device.

6. The Buffer Panel shows the state of the buffer.

7. The File Panel shows some basic information of the loaded file.

8. The Log Window displays the operation history.

A detailed specification of the Programmer Statue Panel is shown in the picture below

and described accordingly to the numbered notation.



N v

ZEMTEL ASUMGASIATSETSOP4E 3
[ Success: 0
Fail: ]

WEET 0 |
O ( Reset |
gCount Down:Disabled
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Connect successiully | 0%
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1. Module number and the ID of the programmer

2. Auto/Cancel button

3. Device name and the manufacturer information

4. Statue bar shows the success/failure of the programmer
5. Statistic information panel

. Count down settings and information

N N

. Connectivity and progression of the programmer/project

8. Serial number

3.2 Programming Procedures
This section provides information on steps for common procedures to programme

devices using SUPERPRO 7500.

Before using the programmer to program a device, make sure that the programmer
is installed properly and that the computer and programmer are communicating
successfully. Make sure that you have the appropriate adapter for your SMD devices,
if applicable. Insert the chip correctly. Follow the guidelines of the standard chip
insertion markings near the pin-driver socket. However, if you select SMD or a
device that requires non-standard insertion, the system prompts you with the

appropriate chip insertion.

321 Hardware prepartaion



Before operating programmer, please install the software first, and connect programmer with PC as follows.

Sys Ctrl

322 Select the device
To open the Device Selection window, choose one of the following options:
® Select the Device Selection icon
¢ Select the Device menu and select the Select Device (Device) option.

The system then displays the Device Selection screen as shown below.
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Device Select
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NOTE: The red device name means that such device(s) need authorization to use.

323

Load data into buffer

One can load data into the buffer by reading data either from a file or a master chip.

324

screen.

To read data from a file, select Load File from the File menu. The system
displays the Load File dialog box. To make sure the loaded data is correct one
can review the information in the Buffer window.

NOTE: Some Hex or S record files contain non-zero file initial address. In this
case, enter the start address in the File Address box.

To read the data from a master chip, complete the following steps:

O Insert the master chip in the socket.
0 Select Read on the Device Operation window in the main screen. The
data will be copied from the master chip to the buffer memory.
0 To make sure the loaded data is correct one can review the
information in the Buffer window.
0 If desired, you can save the data to a disk for later use.
NOTE: The read function is not available for some devices, including those

have been encrypted.
Set options

Click Operation Option from the Option menu to open the Operation Option
Set each of the following options:

0 Insertion Test indicates whether to check the pin contact.

0 Device ID Check indicates whether to check the ID of the device.

O Beeper indicates whether the beeper alarms a sound when the

operation succeeds/fails.

0 Auto Increment Function indicates an automatic increase in the label

number written to each chip.
0 Address Change indicates whether a different start and end address

shall be applied for the programming zone of the device.

To set the order of the batch processing functions, select Edit Auto from the

Options menu. The system displays the Edit Auto screen.

For devices that include the configuration word, you must set the

configuration word before programming to ensure that the chip can be used



on the target system. The configuration words for some devices are contained
in the data file. Therefore, the system automatically loads the configuration
word into the configuration word buffer when loading the data file. For some
devices, you must manually make the selection. Select Device Configuration
Word from the Device menu to open the ConfigWord screen.

e Many devices must meet some special requirements for the programming of
a chip, including special algorithms conventions. Read the device manual or
instructions carefully and adjust the operation steps or buffer data as needed.
If an adapter is required for programming, the system displays information

about the adapter in the device information screen.
325  Execute programming

Insert the chip properly into the socket. If the prompt information indicates a need
for an adaptor, you may purchase the adapter. The operation procedure for the
programming of a chip is described as the following steps:
e Blank Check
NOTE: You can skip this step if the chip is brand new.
The Blank Check fails on electrically erasable chips containing some
information. In this case, perform the Erase operation first. You do not
need to erase EPROM chips for which the data can be overwritten.

e Program

e Verify
NOTE: This step is necessary. The chip must pass Verification before the
programming can be implemented. Some chips provide only the

accumulation check function, such as VerifyCRC instead of a unit-to-unit check function.
Very few chips do not provide the accumulation check function.

e Security or Protect if encryption is required
NOTE: You may need to set the configuration word before performing
encryption. Refer to Device Configuration Word on page 37 for more

information. Select Auto to finish all the operations in one step.



e Execute Production Mode to Program Chips in Batches

Select Production Mode from the Option menu to program devices in large

quantities. This function facilitates the job of the user who programs chips in batches. In order to
program chips in batches, the programmer always conducts the insertion test. The programmer waits
for the chip insertion to initiate while the system displays the following prompt: Please, insert a
device into the socket. Once you have properly inserted the chip, the auto batch-processing
command starts automatically.

3.3 Programming When Connected by Hub
Xeltek provides a connection hub and user can simultaneously operate

multiple programmers by using the hub.

Click menu Programmer -> Module Management, and select the number of the
programmer you want to operate. Picture below shows the interface when

simultaneously operating three programmers.

Every programmer has a unique number. The programmer's first line of the LCD
display will show the number of this programmer. The module that is selected at the
time will be highlighted. The device that is going to be programmed can be different

type(s) in each of the module that is connected through the hub.
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e In normal mode, all operations (i.e. selecting devices, loading documents and
programming) are carried out in the programmer that is selected and
highlighted at the time being.

e In global configuration mode, all the operations are carried out in the

programmer(s) that is selected with the check in tick-box(es).

NOTE: Choose specified hub for XELTEK to connect programmer, and

currently up to 8 programmer can be operated simultaneously.
3.4 Introduction of Interface and Channel of programmer
User can start triggering signal to program automatically, and view programming status by LED

indicator lights on the interface, whose position can be adjusted according to actual condition.

Signal Definition of ISP system



PIN Signal Function

1 CTRO Extended Controlling signal (output, level 3.3V)

2 CTR1 Extended Controlling signal (output, level 3.3V)

3 CTR2 Reserved (input, level 3.3V)

4 CTR3 Complete signal (output, level 3.3V), high level or high pulse
(set in “Operation Option”

5 CTR4 Extended Controlling signal (output, level 3.3V)

6 CTRS Extended Controlling signal (output, level 3.3V)

7 CTR6 Extended stating signal (input, level 3.3V). In production
mode, Once low level is detected (keep more than 400ms), it
runs “auto” automatically. Don’t keep low level all the time
which is taken as triggering status.

8 GND GND

9 VCC Voltage 3.3V

10 GND GND
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Instruction Of 1S03’s Channel

IS03 supports programming multiple channels at the same time.

16-channel:
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User could use Expansion board to check programming status or trigger starting signal. JP1 of the board is
connected with programmer (connecting line is provided by Xeltek). JP2 and 16 controlling signals of LED are
user’s concern.

The expansion board is composed of one 10-pin controlling interface, and connected to programme. It includes two
functions,

1) There are two signals on JP2, one is starting signal received from exterior and one is over signal sent to exterior.

The two signals on the board are separated by optocoupler TLP124 and externer signal. Extenerl signal is connected
to 3" pin of JP3 (GND is 5" pin). If the voltage of start signal is between 9V and 24V, 10K resistance is adopted for
R5. While if the voltage is between 3.3V and 5V, 2K resistance is adopted. This is remarked on the silkscreen layer.

Programmer will start running when it receives a low pulse signal which should keep longer than 400ms.
Optocoupler has backward action, starting signal will be triggered by high pulse signal lasting longer than
400ms.

Over signal is connected to the 4™ pin of JP3(GND is 5™ pin). It keep low in normal, and when programming
finished, it generates a high level or high pulse depending on user’s settings.

1) Led Controlling
16 LEDs share the same cathode with red and green color. Take the fllowing chart for example, RGB1 is red
signal and RGB2 is green signal. The resistor array RP1-RP8 on the board is current-limiting resistance.
RP1,RP3,RP5,RP7 are red resistances while the others are green. It user wants to use external LED, he can lead
out the three signals*16 groups, change the resistance of limiting current and keep the current between SmA
and 15mA.



Jumper wire is used to to supply power for controlling board,. VCC33 is supplied by programmer while
VCC50 and VCCP are supplied by exterior (if necessary). VCC of SWis the level for LED.If the level is 3.3V, the
short circuit is connected to VCC33 and VCC.If the level is 5V, the short circuit is connected to VCC33 and VCC,
and then The 1* pin of JP3, that is, VCC50 , should be supplied by exterior.

VCCU of SW2 supplies voltage for signal over. It’s connected with VCC33, VCC50 or VCCP, short circuit
connecting. VCC33is supplied by programmer while VCC50 and VCCP are supplied by external power.

SW2
VCCP SW1 IP3
1 VCC50
YVCCU VCC50 1
2 1 VCCP
VCC50 VCC 2
VCC33 3 VCC33 : START 3
4 3 OVER X
CON4 CON3 GRKD 5
CONS5

Signal Definition of JP2’'s controlling socket (Corresponding to 3.4)

PIN Signal Function

1 CTRO Data Wire of LED (output, Level 3.3V)

2 CTRI1 Clock Wire of LED (output, Level 3.3V)

3 CTR2 External starting signal (input, Level 3.3V )

4 CTR3 Over Signal of Programmer (output > Level 3.3V)
5 CTR4 Extended 1/0 (I/0O, Level 3.3V)

6 CTR5 Extended 1/0 (I/0O, Level 3.3V)

7 CTR6 Extended 1/0 (I/O, Level 3.3V)

8 GND GND




9 VCC Voltage 3.3V

10 GND GND
P2
CTRO CTR1
—_—} -
CTR2 ; i g CTR3
—_ 1
CTER4 - 6 10 CTRS
0 ° -
CTRS - g 0 GND
V(33 4 9 10 b GND
HEADER 3X2

Note: In the early version CTR2 is the external starting signal. Later CTR6 takes place of CTR2 to be compatible
with the former version. So connect CTR2 with CTR6 of JP2 and disconnect CTR2 of JP1 with programmer.

Bellowing is the size drawing
Size of board: 90cm*90cm

Distance of locating hole : 80cm*80cm

Size of locating hole : 3.2mm
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Chapter 4 Functions and Commands

This chapter provides a detailed specification and explanation of the SUPERPRO»
software. It includes the description of the functions and commands that is listed as

below,

® File Menu and Tool Bar (4.1)
® Project Menu (4.2)
® Device Menu (4.3)
® Option Menu (4.4)
® Tool Bar (4.5)
® Log History Window (4.6)
4.1 File Menu and Tool Bar
The File menu provides access to the commands of Load, Save, Recent Projects, and

Exit. Each function is described in the following sections.

4.1.1 Load File
There may be one or more data buffers in the device. If several data buffers are
displayed after you have selected the device, refer to the name and the data manual

for the meanings of the buffers. The two data types of the device are Data

(HEX/ASCII) and Fuse.

® For most EPROM and SCM, the data type is Data (HEX/ASCII).

® The data type for PLD device is Fuse.
After you select the device, the software automatically will identify the data buffer
type. You can review the buffer data types if you open the Edit dialog box for the
data buffer. When some file data are loaded into the data buffer, the following rules
apply:

* With a HEX/ASCII data buffer (EPROM, MCU etc.), the system assumes that

8 bits of the data are valid.



¢ With a JEDEC buffer (PLD/PAL), the system considers the lowest bit (1 bit) of

the file data valid.

Select Load from the File menu to open the Load File dialog box, as illustrated

below. The red labels refer to the numbered notations follow this figure.

Load File

Buffer: FLASH _V' 1

File Marme: 4 ” l
File Type: Binary 3 V|

Load maode: :Nnrﬁl _s-l \'_*_|

Buffer offset: |D 5

File offset: IIII & :

F ]

1. Buffer. To select the Buffer name from the drop down list. The system loads
the file data into the buffer accordingly.
2. File Name. To enter the name of the data file to load it, or you can select

Browse and choose the file using the Select File box .
3. File Type. To select the type of the file from a drop down list. Different file

types are included here, e.g. Binary, Intel Hex, Motorola S record, JEDEC,
POF, TI, etc.
4. File Mode. To select one of the following File Modes from the drop down list:
® Normal to load the whole file
® Even to load the first byte and discard the second byte out of every
two bytes
® Odd to discard the first byte and load the second byte out of every

two bytes



® 1st byte of 4 to load first byte and discard the other three bytes out of
every four bytes
® 2nd byte of 4 to load the second byte and discard the other three bytes
out of every four bytes
¢ 3rd byte of 4 to load the third byte and discard the other three bytes
out of every four bytes
® 4th byte of 4 to load the fourth byte and discard the other three bytes
out of every four bytes
® 1st2_byte of 4 to load the first two bytes and discard the other two
bytes out of every four bytes
® 2nd 2_byte of 4 to load the last two bytes and discard the other two
bytes out of every four bytes
5. Buffer Address. To indicate a different initial address of the data being
loaded into the buffer.
6. File Address. In case the file type has a non-zero start address, enter the data
offset address in the File Address field. Make sure to enter the correct
address, because an incorrect file offset address causes part of the buffer to be

filled with FF (or incorrect data).
7. Buffer clear on data load. Tick this checkbox will enable the user to fill the

data buffers with the specified data.

NOTE: Ticking the checkbox of Custom File will disable most loading option.



adite ., Bz ==
File Mame:

File Type: Binary

Load mode: Mormal

Buffer offset: 0

File offset: 0

[¥] Buffer clear on data load 0

4.1.2 Save File
Select Save from the File menu to save data in the current buffer to a disk file. A
dialog box titled as Save File will be displayed and the saving options are similar to

those in section 4.1.1 Load File.

Save File %]

Bufer FLASH vl 1

File Mame: 2 ” ]
File Type: |Elinarg.r v| 3

Buffer offset; ] 4

Data Size: 200000 5

1. Buffer.
2. File Name



3. File Type
4. Buffer Address

5. Data Size. To enter the save data size in number of bytes.

4.2 Project Menu
The project file contains all of the information and preparations before programming.

It can also be used to restore the working environment that has been saved
previously. The project file includes:
® The current device's information, such as:
0 Manufacturer
0 Device type
0 Pin size
0 Data file name
0 Current buffer data
NOTE: The buffer data may differ from the data file due to revisions.
® All Operation Option settings
® The content of the Auto mode
® Software module related to the project
NOTE: The project content is related to the programmer software. If the software
has upgraded or has been re-installed to another folder, the saved project files

become ineffective
4.2.1 Load Project

Select Load Project from the Project menu to load a project file. Select the file in the

File dialog box. Following the information that is provided by the project file, user

can change the device(s), data in buffer, and operation option accordingly.

If the project contains “dynamic password”, a random serial number will be displayed. User should offer the

serial number to the project maker. The project maker generates password by the tool “Password Generator”
(please refer to “““Password Generator” for details). Then User input the password and load the project.



Load project

Project name: Citestpr EI

Input passwaord: Random code:8mu1VAElx

Project description{Mo more than 500 characters):

OK ] ’ Cancel

4.2.2 Save Project Files
Select Save Project Files from the Project menu to save the current working
environment to a specified project file. To ensure the security of the data, you can

encrypt the project file.

Save project S|
Project name:

Input password:

Confirm password:
[] Enter protected mode after loading the project
[] Dynamic Password

Project description(Mo mare than 500 characters):

Ok | ’ Cancel

When the option “Enter protected mode after loading the project” is selected, Dialog “Protected mode
Setting” pops up. Please refer to “Protected mode” for details.



Protected Mode Setting e

Input password:

Confirm password:

[[|Keep "Load Project” enabled
[] Disable "Edit Buffer”

[ Only "Auto™ allowed

[ OK ] ’ Cancel

Dynamic Password: Please refer to “Load project” and ‘“Password Generator” for details.

4.2.3 Manage Project Library

The stand-alone operation is when the programmer hardware is not connected to a
computer, and uses information saved in its own module for volume production.
The stand-alone file includes all the information needed for programming the device.
This enable the user to prepare the project file(s) before starting the programmer's

operation.

The project file being saved in the stand-alone mode will be manageable using
Manage Project Library function. This type of file can be stored in the SD card

incorporated in the programmer.

NOTE: 1) Besides using Manage Project Library function, user can also copy the

project file(s) by SD card replication;
2) SD card's file system must be FAT32.

The figure below shows a typical Manage Project Library window



asge et . ===

Project Manufacturer Device Size(Byte)

@w25q15.... WINBOMND W2sQ128BV 16982472
1 | 1 | 3
[Send F'rnject...] ’Delete F’mje::t] [] Transmit with low speed

Some basic commands related to the project file operation are:
® Send Project. This will send the existing project file(s) to the SD card. One
can also encrypt the SD card to protect the data.

® Delete Project. To delete the project being selected.

There are many SD card manufacturers in the market and the quality varies a lot

across different brands. The ones from Kingston,,,, and Sandisk,,, is recommended.
The default operation speed is high transfer rate, where low transfer rate (tick the
check-box) is preferable when the sending project operation fails. If there are many

large project files need to be sent, then replication of SD card is recommended.

4.2.4 SD card encryption
SUPERPRO,, 7500 enables the encryption of SD card. Some SD card encryption
operations are,

® Set password. To set a 6-character password for a SD card. Once a SD card is

protected by a password, it becomes encrypted and needs the password for



any operation.
¢ Unlock. To enter the correct password enable operation on the SD card when

it is connected on-line. However, if the SD card is off-line/disconnected, the
user has to unlock it again for any other operation.

®* Erase Password. This operation actually wipes all the information that is
stored in the SD card and removes the password. After this, the SD card
needs to be format using FAT32 file system, so as to be compatible to
SUPERPRO,, 7500. One does not have to unlock the SD card to carry out the

Erase Password operation.

4.3 Device Menu

4.3.1 Device selection

Refer to section 3.2.1 for the operation of device selection.

4.3.2 Device information
Click Device information will display the device information in a window (see

the figure below).



General Information

Manufacturer : ZENTE

Device TASULGAZ1ATS

Algorithm CFOBHATAD Device Information
Package :TECP4S

Adapter :EX1004 —Order id of adapter

Special Informa

Thiz algorithm provides three bad bhlock handl
"Partition".

The "2Skip Bad Block” metheod iz a simple and ¢
next good block when programming.

ard Copy"™ method may-lose data when the

yod to use it for a mass productian programming
Spasial formatiohpfidevifg cnip,

"Partiticon™ method 1=

ficre intelligent
method supporTE Ino =tile programming with bloc
gseveral files to one programming file and also ¢
partition table file need to be loaded intoc the

We also support special Bad Block Management
and so on. Anything about customized Bad Block I

Adapter Information

The picture below shows the correct position of
EX1004

Adapter

Information

4.3.3 Manage data in buffer
There are two major types of buffer, Fuse Buffer and Data Buffer (HEX/ASCII buffer).
In following section the operations of these two types of buffer is described and a

typical buffer operation window is shown below.

4.3.3.1 HEX/ASCII Data Buffer



ED C4-76 F1 B& F5 02 30 95 CA n.k.0...¥...
000000010 6B 7D 58 C1 0B &2 B4 CB-D4 7F 1A A2 71 7D DE 5D
000000020 &D 44 98 42 CS5 &E CB DB-A7 FB C4 4C 7C 46 C5 E3 mD.B.n.....L|F..
000000030 26 37 63 F1 86 BB 2D D8-42 71 BE &6 C5 A7 F5 61 &7c...-.Bg.f...a
000000040 87 84 32 63 8E 86 24 E8-35 30 91 A6 2C FC 55 1D ..Z2c..$.50..,.0.
000000050 CO 97 BF 6E 5C 4D 38 70-50 CZ 25 01 D2 E4 OF %A ...n\M8pP.%.....
000000060 42 1D 01 27 B3 CD 32 15-A6 F7 E4 AC 18 3B B8C SF
000000070 CO 04 33 E1 92 02 1C BB-87 DB A7 1C AO 1D 75 30
000000080 25 78 CD 33 3B 2A 3F 88-84 BA 87 05 4A ES B4 52
000000050 AE E6 89 F2 2E C1 23 EO-&E 22 DC SE 38 3B 70 44
D000000AD C1 FB S5E 32 2E 84 91 &9-56 EO 40 5A CA EF 13 1D ..

0000000BO 13 A4 87 48 3A 71 53 08-8E 00 B8C 70 Al 24 46 10 ...H:qg.....p.
0000000CO 94 OF 7C CA 94 C5 71 E1-AS D1 D8 53 S9E 236 F1 69 ..]|...qg....5.6.1
0000000D0 75 AE Fé& 8C BD FC BS SA-6D DE 7E FS E3 C2 3F AB
0000000ED 2% 1D EE A3 76 D4 27 18-F8 F4 17 97 DO A5 S8 SD
0000000F0 5F 59 9D 65 CO 49 D1 FF-95 22 7B R2 07 FB A5 43

Current Address: 0 h Checksum: UIXFII:UEZEUI h
StartAddress: 0 h EndAddress: 1FFFFF h
| Locate | [ Fill ] ’ Copy | [ Search l ’ Search Mext l | Radix ] ’ Swap ]

[ OK ] ’ Cancel ]

® Locate. Enter the address of the data you wish to display and select OK to
quickly move the cursor to the desired location.
® Fill. To fill the data in the buffer between the Start and End address. For Fuse
buffer, the data must be 0 or 1, and for Data Buffer (HEX/ASCII buffer)
® Copy. Select Copy to open the Copy Buffer dialog box.
0 Enter the start address in the Start Address field.
0 Enter the end address in the End Address field.
0 Select OK to copy the data between the start address and the end

address, beginning with a new address. Otherwise, select Cancel.

® Radix. Select Radix to toggle between the HEX and DEC memory address
display.

® Search. Select Search to search for a specified string. Select Search Next to
begin the next search for the specified string

®  Swap. Select Swap to open the Word Swap dialog box, illustrated below.

Select the Word Width option to swap high byte and low byte according to
the specified width in the address range and select OK. Otherwise, select

Cancel.



Swap . t.- et S|

Width

@ 16 Bits (2 Bytes)

() 32 Bits (4 Bytes)

() B4 Bits (8 Bytes)

[ OK ] [ Cancel ]

For example, if the data buffer address 0-10(HEX) is:
123456 78 90 AA BB CC - DD EE FF 11 22 33 44 55
Then after swapping the data, it would look like this according to the selected
word width:
0 16 Bits (2 bytes)
341278 56 AA90 CCBB - EE DD 11 FF 33 22 55 44
0 32 Bits (4 bytes)
78 5634 12 CC BB AA 90 - 11 FF EE DD 55 44 33 22
0 64 Bits (8 bytes)
CCBBAA9078563412-5544332211 FF EEDD

4.3.3.2 Fuse Buffer
When you select Edit from the Buffer menu with the appropriate file type, the

system opens the Fuse Buffer Edit window, illustrated below.



00Do0oeoD0 111111111133111113111131171111333131331111131313111111
000000030 11171131377773133373777313773333337733373333337733331313111 fl
000000060 1111131337771313133377733773333373773337331333377333313131113
000000090 11171131337713131333777313773333377313373313337377333313131113
0000000CO 111711313777131313337773137773133337731337331333377333313131113
OQQ000QOFD 1111111313133313313331333333331333333133333333333313311
000000120 11171133377711333377731377333337733373333373773133313131113
000000150 111711337771313133737773137773333337733373333337333313131113
000000180 1117113137773133337773377733333773337333337373133313131113
0000001BO 111711313771313133737773137773333377333733333377333313131113
O000001ED 111711337713131337377731377733333377333733133337333313131113
000000210 11171131377713131333777313777333337733373333337733331131113
000000240 111113137771313133377731377733333773337333333773333131131113
000000270 1111131377713131333777337773313337733373313333773133313131113
0000002A0 111711313771313133377731377731333377333733333377313331311113
0000002D0 11171131337771313131337773137733333773337333333773333131131113

CurrentAddress: o n Checksum: OX1AEATA h
Start Address: 0 h End Address: D8z2c i h
[ Locate | [ Fii | [ Radix |
[ ok | [ cance |

The data for editing is either 0 or 1. Refer to the data manual of the device and the
JEDEC to determine which of the following explanations for the data apply.
® 1 represents an intact fuse and 0 represents a blown fuse, or

® 1 represents a blown fuse and 0 represents an intact fuse
4.3.4 Device Configuration Word

Important: The device configuration word varies from device to device. Refer to the
device data manual for more information about the configuration words. Set the
configuration words according to the requirements of your target system. Otherwise,
you cannot use the device normally even if it is normal when preparing and

verifying the program.

Some single-chip microcomputers allow special working modes, such as the storage
area mapping, the watchdog time, the clock, or the encryption. Set these special

modes through the Device Configuration Word option.

The user files contain the configuration words of some devices. When you load these



files, the system automatically loads the configuration words into the configuration
word buffer. However, you must select the configuration words for some devices

manually.

Select Device Configuration Word from the Device menu to open the ConfigWord
dialog box. The following sample illustration shows the configuration word for

EON,EN25B16(Bottom Boot). It contains the watchdog and three protection modes

Fagel |

Memory Frotection Options Status Begz. Write Protection
@ Hone @ Disabled
) Lower 1/512 ) Enabled

(7) Lower 1/256
) Lower 17128
) Lower 1784
) Lower 1732
) Lower 1f2
RNl

| ok || cancel

Some single-chip microcomputers include many items for the configuration word.
The items may appear on separate tabs or pages. Make sure to set all the items on all
pages before programming a chip. The input of the configuration word can be
divided into several ways:

® The 8-bit (byte) edit box input

® The 16-bit (word) edit box input

® The single choice input (select and deselect, choose one out of two)



® The multiple choice input (choose one out of many)

The configuration words for chip programming are classified into two categories:
® Ifthe configuration word contains some protected items, then you cannot
verify the items after preparing the program. When preparing the program,
the programmer automatically shields the protected items and writes the
other items. Select Security or Protection to write the protected items.
NOTE: If you select None as the Protection option, the system does NOT
carry out an operation when performing Security or Protection.
In some devices, the configuration words cannot be separated, so the system
does not write the configuration word when preparing the program. To write
the configuration word in these cases, select the corresponding item, such as
Write_Option.
Some FLASH devices also use the configuration word for the protect
operation and to execute and display the segment protection.
4.4 Option Menu
The Option menu includes items to help you program in a specific mode to meet the
targeted system requirements. Before programming a chip, make sure to select the
necessary settings. The General view of the Operation Option screen is illustrated
below. The Operation Option screen includes four tabs:

® General
® PBuffer

® Auto.Inc
® Count

Each view is explained in the following sections
4.4.1 General



General
Basic Settings
Buffer [¥] Pins Check
Auto.nc
Remove interval(s) 4 Insert interval(s) 2
Count
Verify mode

@ Once with Voo
() Twice with Voo+-3%5

() Twice with Vooc+-%10

[ OK H Cancel ]

1. For chips with 48 pins or less or for chips with an adaptor that reduces the
chip to 48 pins or less, select Insertion Test to have the programmer check the
pin contact status before programming. The test includes a check for poor

contact, wrong direction, chip insertion, and chip insertion orientation errors.

2. Select ID Check to have the programmer read the Electronic Identifier Code
from the chip to identify the manufacturer, the device type and the
programming algorithm code. If you have already selected the device, the

default for this option is checked.
3. Select Beeper On to turn the beeper on or off. The beeper makes a sound to

indicate the results of operations such as Insertion Test error, ID unmatched,
programming successfully completed or failed.

NOTE: Not all programmers include a beeper.

4. Indicate the mode for verifying the data by selecting one of the Verify Mode

options. These options refer to the voltage of the pin VCC, which may vary



when the programmer verifies the data. The manufacturer provides the
MinVcc and MaxVcec values for verifying the data.
VCC(+/- 5%) or VCC(+/- 10%) is adopted for the verification. If VCC = 5.00V,
select one of the following options:

® VCC=5.00V and verify the data once

® VCC=4.75V and VCC = 5.25V, and verify the data twice (+/- 5%)

® VCC=4.50V and VCC=5.50V, and verify the data twice (+/- 10%)

4.4.2 Buffer

General

Auto.Inc

FLASH(0x0-0x1FFFFF)

Count

Option
[7] Buffer clear on data load

[7] Buffer save on exit

[ oK H Cancel ]

The default programming method is to program the device from the start address to
the end address. However, you may choose to program only a part of the chip, such

as with most E/EPROM (FLASH) devices. (Double click on buffer name and set the range of programming)

4.4.3 Auto Increment (Auto.Inc)
Auto Increment provides two methods of generating the serial numbers: Auto

Increment and User Defined. This function is not available in stand-alone mode.



[*]iEEnahle Autolncrement
Auto.Inc Option

Buffer | MARD w

Format |Hex V|

Direction |Fr|:|m high address to low V|

Start 0
End u
Step a
Initial Walue

[1Users Define

Dl File:

SM's File:

37 of 51




NOTE: The serial number is the content required by some applications that must be
written in a certain area for every chip. This information includes the product

sequence number and the MAC address.

To have the software generate the serial number, select Enable AutoIncrement.
1. Enter the automatic start buffer address in the Start Addr field.
2. Enter the automatic end buffer address in the End Addr field.
3. Enter an increment value less than 10 in the Inc. Step field.
4. The Autolnc Format defines the start value and the overflow value. The
overflow value is the number at which the increment ceases and carries to the
next address, which becomes the new start value.
® Select Binary to set the start value as 0 and the overflow value as 256.
® Select ASCII Decimal to set the start value as 30 (hexadecimal
representation of 0) and the overflow value as 39+1 (the hexadecimal
representation of 9).
® Select ASCII Hex to set the start value as 30 (hexadecimal
representation of 0) and the overflow value as 46+1 (the hexadecimal

representation of a number greater than F, where 9+1=A).

To define the increase of the serial number, select User's Definition. You must be
authorized to use this function. If so, you can change the data as desired in the 4K

byte range.

4.4.4 Count

The Count view of the Operation Option screen is illustrated below. This screen
allows you to change the default setting regarding the statistical work of the
programming status. In the default case, it is only effective for the function

program".



General [F] Readld
Buffer Program
Auto.Inc [ Read
Count [T Verify
[7] BlankCheck
[]Erase
[ Protect
[ Unprotect
[ ok || cancel
4.5 Edit Auto

The Auto function organizes the different functions of the device into a sequential
group and carries out the functions in order, similar to a batch command.
Edit Auto enables edit functions and operations, in order to automatically execute

the programming procedure according to pre-arranged functions and operations. As can be seen from the
figure above, user can select one certain function/operation and

Add, Delete the selected one, or Delete All to cancel all the previous arrangement.
4.6 Tool Bar

The tool bar provides a quick way to execute common functions. The toolbar from
the main SUPERPRO screen is illustrated below. Each tool is labeled with a number

and described below.

TP ¢ % 8.0 9

T 8 8 10 14 156 16



9.

. Load file

. Save file

. Load project

. Save project

. Edit buffer

. Calculating the Checksum
. Select device

. Device information

Device configuration word

10. Edit Auto

11. Option

12. Logic test

13. Production mode

14. Factory mode

15. Global settings

16. Help

4.7 Log History Window

User can create a log file to have the system save Operation Information window

content into a log file when you exit the program. Select Log File from the Option

menu to open the Log File dialog box, illustrated below. The red labels refer to the

numbered explanations below

oorie . ==

Cption
i) Mever 1
@ Mew 2
) Append 3
Filename:

Csp7000WinVogf 4

-

1. Select No to delete the log file. The system will not create a log file on exit.



2. Select New to overwrite the existing log file every time the program starts.

3. Select Append to add the log file information at the end of the existing log
file each time the program starts.

4. Enter, edit or Browse for the full path name of the log file in the Log file's

name: field.
Chapter 5 Frequently Asked Questions (FAQ)

You can monitor the programmer operations through the Operation Information
Window and message window. This chapter helps define common problems related

to programmer actions and errors.

5.1 Dealing with Data Files

This section explains common problems involving the File Type dialog box.

5.1.1 Solve Invalid File Type or File Data Overflow Error

The data for programming is usually stored in the data file. Commonly used formats
are Intel Hex, Motorola and Tektronix. The files of these formats keep data in text
mode, which include data and address information. Because the offset address is not

always zero, you may incur errors when loading the file directly.

For example, the location of data in buffer (as viewed in the Edit Buffer window)
may be incorrect or you may receive an error message when loading the file, such as
Invalid file type, or all file data overflow. Select one of the following options to
solve this problem.
® Confirm the file type and ensure the buffer can load all the files.
® Find the offset address of the file. When loading the file, select the Show
Offset Address (Minimize) After Loading option to display the start address
of the file after the file is loaded.



5.1.2 Separate File Data for Programming
By using the File Mode selection in the File Type dialog box, you can select the data

of a file and write it to several chips of the same type. This allows you to load the file several times
according to your needs. There are three methods for separating the

file data:

® Based on byte (8bit), divide the file into two parts by the odd and even
address. Program the two parts into two chips respectively. When loading the
file, select Even as the File Mode to write the data in the addresses 0,2,4,6, etc.
to one chip. Select Odd as the File mode to write the data at the address
1,3,5,7, etc. to the other chip.

® Based on the byte (8-bit), divide the file into four parts by address of the first
byte, the second byte, the third byte and the fourth byte out of every four
bytes. Program the four parts to four chips respectively. When loading the
file, select the 1st byte of 4 as the File Mode to write the data in the addresses
0,4, 8, 12 (or C if HEX)), etc. to one chip. Then select 2nd byte of 4, 3rd byte of
4, and finally 4th byte of 4 to write the remaining data to the other three chips.

® Based on the word (16-bit), divide the file into two parts by address of the
first two bytes and the last two bytes out of every four bytes. Program the
two parts to two chips respectively. When loading the file, select the 1st two
bytes of 4 as the File Mode to write the data in the addresses 0, 1, 5, 6, etc. to
one chip. Then select 2nd two bytes of 4 to write the remaining data to the

other chip.

5.1.3 Program Two or More Files to One Chip
User can load several files into the buffer and write them to the chip. The following
explanation gives an example of programming three files (Samplel, Sample2, and
Sample3) to one chip. The example assumes the following:
®  Write the data from the address 200 (Hex) of the file Samplel to the address 0
of the chip.

®  Write the data from the address 0 (Hex) of the file Sample2 to the address 3000 (Hex) of the



chip.
Write the data from the address 4000 (Hex) of the file Sample3 to the address

4000 (Hex) of the chip.

—

. Select Edit from the Buffer menu. Make sure that the Buffer clear on data load

option is not checked.

[\

. Select Load from the File menu to load the Samplel file.
0 In the Buffer Address field, enter 0.
0 In the File Address field, enter 200.
3. Select Load from the File menu to load the Sample? file.
0 In the Buffer Address field, enter 3000.

O In the File Address field, enter 0.

N

. Select Load from the File menu to load the Sample3 file.
0 In the Buffer Address field, enter 4000.
0 In the File Address field, enter 4000.

5. Continue with programming.

If there are no changes in the file requirements or content of the three files (Samplel,
Sample2, and Sample3), you can save the data in buffer to a new file, such as

Sample4, for easy loading and programming next time.

5.1.4 POF Format Files
When programming ALTERA PLD devices the system saves the data in POF format
files. When loading a POF Format file, the system displays a File Type dialog box.
Select one of the following:
1. POF file: The system transforms the data into the Fuse data and checks the
data when you load it to the buffer. You may receive one of the following

errors:
0 Unmatched file to this chip: This POF file does not match this chip. The

POF file is related to the device when it is compiled. The error indicates

that this POF file is not for this device. Replace the chip with a matched



one.
0 The POF file has errors.
0 Load POF file dll error (not found): An auxiliary file has errors. Contact
technical support for assistance.
2. Files of other formats are mainly the JED files. The system saves data in the
buffer in a JED file after reading the chip. You can use this format the next

time you load the file.

5.2 Adapter Selection

There are two types of adapters: universal and specific.
® Universal adapters are applicable for all devices of the same encapsulation
and the same number of pins.
® Specific adapters are applicable for certain devices only. For example, if the
number of the pins for economical programmer hardware is not enough,
specific adapters may solve the ,insufficient number of the pins® problem.
This way, the programmer can also support devices with more than 48 pins
To use devices with pins between 48 and 144, you can choose either the universal
adapter or the specific adapter. To use devices with pins more than 144, you must
use the specific adapter. The Device Information screen displays adapter

information.

5.3 Other Messages

Other error messages are explained below.
® Please edit 'Auto’ first: The Auto consequence is blank. Edit Auto and try
again.
® Enter a string to search for: The Hex Edit Search dialog box is blank. Make
sure to enter a specified string or ASCII codes to search for in the Buffer Edit
dialog box.

® The string for search is blank. Input it in Search dialog: Enter a string in the



Buffer Edit dialog box. Then you can use The first time search, Continue to
search, or Search Next functions.

Search pattern not found!: The system did not find a matched string or
ASCII code.

User chip is MfgID = 0089, DevilD = 0051: This display on the Operation
Information window indicates that the chip's ID detection function detected a
different ID than specified in the manual.

ID check error. Ignore: You can ignore the detected ID error and continue the
operation.

ID check error: The operation stops because of the ID check error. If you have
good knowledge of this chip, you may ignore the ID error and continue the
operation. Exercise caution to avoid damaging the chip.

Pin check error. Ignore: The system indicates an error during the pin check.
Ignore it and continue.

Pin check error: An error occurred during the pin check, and the operation
ceased.

Programmer not found: The programmer is not connected to the PC or it is

connected improperly. Check the connection.

Programmer not ready: Turn off the programmer power switch and turn it
on again after a few seconds.

Programmer is running: The programmer hardware is operating. Wait until
the operation is finished.

File open error: The open file operation failed.

Out of Memory: The memory overflows.

Production mode isn't available for this chip: Since the production mode is
dependent on the pin check, the chips without pin check function are not
applicable for production mode.

Cancel production mode: Cancel the production mode.

Too long file name: The file name is too long.

User cancel: The system displays this message after you select Cancel on the



Status bar.

¢ Can't cancel!: The Cancel operation has failed.

® Not a project file: The file selected is not a project file. After the software is
updated, the software may not be able to identify a previously created file.

You will need to create the file again.
Appendix

XELTEK periodically publishes upgrade software on the XELTEK website. You can
download and upgrade your software from the website. Non-users may download

the software for evaluation.

Troubleshooting
If the User Manual does not answer your questions, first contact your sales agent or
the distributor. If you still need technical assistance you can call XELTEK between
Mon-Fri 7:30AM-12:00PM & 1:00PM - 4:30PM (PST). Make sure you have your
product serial number before calling. Before contacting XELTEK, check the
following to ensure you get the best service.
® Read the User Manual.
® Ifyou receive an error message that is not explained:
0 Make sure you can repeat the circumstances that created the error.
O Write down the error message.
® Make sure you have your product serial number.
® Check your computer configuration, including computer brand, free memory
size before starting the software, the video adapter brand, and the operating
system.
® Make sure you are at your computer when you call so the engineer can guide

you through the solution.

Contact Information



XELTEK

Zijin (Jiangning) Technology Incubation
Special Park,

Jiangning, Nanjing, P.R.China 2111011

+86-25-68161208

General Consultation

+86-25-68161208

Order/Sales
+86-25-68161226

Email: zjb@xeltek.com.cn

Technical Support
+86-25-68161208

Email: czg@xeltek.com.cn

Website: http://www.xeltek.com.cn

License Agreement

The copyright of the program and the User’s Guide remain the property of XELTEK.

You may:
1. Copy the program for back-up purposes ONLY in support of its use on a
single computer.
2. Transfer the program and license to another party if the other party agrees to

accept the terms and conditions of this agreement.

You may not:
1. Use this product on a computer system or network that allows the program

to be operated by more than one user at the same time.



2. Modify, copy, or transfer the User's Guide or other documentation or any

copy.

3. Decompile or disassemble any program modules or encrypted devices.



